High Definition Intelligent IR
IP Auto-tracking Speed Dome Camera

User’s Manual
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Chapter 1 Precautions
In order to avoid danger and operate the products correctly, please read this manual carefully
before installation.
The precaution contains two parts “Warning” and “Note” as following:

Warnings alert the user to avoid

Cautions alert the user to avoid

the potential risk of death or serious

the potential risk of injury or

injury

property damage

Warning:
● Please use AC 24V power supply meeting SELV(Safety Extra Low Voltage) and in accordance
with IEC60950-1 compliance with Limited Power Source
● Please contact nearest distributor or service center if the products don’t work properly, do not
remove or modify the device in any way (unauthorized modification or repair problems caused
by your own risk).
● Please don’t expose the indoor product to rain or moisture.
● The installation should be performed by professional staff, and comply with local regulations.
● Please mount easily using power protection device in the wire installation.
● Please make sure the connection can withstand at least 50 Newtons vertically downward pull.

Note:
● Please check if the power supply is correct.
● In transportation and storage process, please prevent stress, severe vibration and immersion to
avoid any damage
● Please don’t touch the image sensor and housing directly, if necessary, please gently clean with
alcohol dampened.
● Please don’t touch the cooling components directly, in order to avoid burns.
● Please don’t focus aligned glare (such as lighting, sunlight, etc.), otherwise it will easily lead to
too bright or pull light phenomena, also affect the image sensor life.
● The laser beam may burn the image sensor, so when it is used, please don’t expose the image
sensor in laser beam.
● Please don’t put it in the damp, dusty, extreme heat, extreme cold, strong electromagnetic
radiation places.
● Please make sure the installation location keep enough distance from the electromagnetic
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sensitive devices surrounding to avoid electromagnetic interference.
● Please prevent heat buildup and keeping the surrounding ventilation.
● Please prevent the speed dome from water or any liquid.
● The product must be carried by original package, either in delivery to users or in return
delivery to the factory for repairing. Otherwise, damage caused in transportation will not be
covered by warranty.
● The battery replaced incorrectly will lead to use of exceptions, and we don’t recommend users
to replace directly; If necessary, please use batteries recommended by the manufacturer (for
devices with battery).
● Please don’t dismantle internal parts, please turn to qualified maintenance professionals to
carry out repairs
● Long-term high speed cruising may cause slip rings broken and belt aging, also affect speed
dome life.
The wiper will stop working under Zero degree automatically, prevent equipment damage and
prolong the service life, there is no rain, please do not use wiper to avoid damaging.
The running speed of the PTZ will be automatically adjusted according to the external
environment, the super low temperature environment (-20 degrees below) the PTZ running
speed will be slightly decreased.
● Working Environment
Speed Dome
Environmental temperature

-40℃～+65℃

Moisture

<95%（Non-condensing）

Atmospheric pressure

86～106KPa

Power

AC24V/2.0A

Note: make sure outdoor installation meets water-proof requirements.
Assembly environment description:
In order to avoid the fog in the PTZ cover, please assemble the cover in the ventilation and dry
conditions, and to ensure that PTZ screw tightening.
Different models of PTZ function is slightly different, specific functions, please refer to the actual
functional interface.
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Chapter 2 Structure
Front view

Side view
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Chapter 3 Functions Description
3.1 Features
1. Built-in Decoder
● HD IP Speed Dome, support 720P 25/30fps or 1080P 25/30fps output. 3MP HD PTZ support
QXGA 25/30 fps output.
● Support English menu
● Support standard Onvif
● Power-off protection, no data loss
● RJ-45 port network port
● Support PELCO_P,PELCO_D protocols.
● Support 3D location
● Support standby function
● 470 programmable presets
● 8 cruising tracks, each cruising track has 32 preset positions
● 8 auto scan tracks, the left and right boundaries and scan speed can be set
● Support OSD, date and time display
● Support 1 channel alarm input and 1 channel alarm output(Auto-tracking PTZ support 8
channel alarm input and 2 channel alarm output, standard PTZ support 1 channel alarm input
and 1 channel alarm output)
● Support TF storage and local capture
2. Integrated Universal Speed Change Rotator
● Manual Speed:0.05°～160°/s, Max speed 240°/s
● 360°continuous pan rotation, high speed dome camera -15~90，IR high speed dome camera
-16~90
● Stepless speed change, auto zoom/speed matching
● Classic double bearing structure, more stable operation
● Delicate stepping motor, stable, sensitive and accurate
3. All-weather Outdoor Design
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● Sensor intelligent control
● Double housing structure
● IP66 water proof
● Support anti- lightning and anti-surge
4. Camera Module
● Support auto iris, auto focus and auto BLC
● Mini. Illumination 0.5Lux/F1.6(color),0.095Lux/F1.6(B/W) Starlight series PTZ:
0.002Lux/F1.5(color),0.0002Lux/F1.5(B/W)
● Support 3D noise reduction and WDR
5. Network
● Support Ethernet control
● Support remote view and control by browser and client software
● Support Micro SD card
● Support NFS
● Support remote view and control by browser and client software
● Support Micro SD card
● Support for NFS record
● Support four levels user authority
●Support for authorized users and passwords, support HTTPS encryption and IEEE 802.1x
network access control
● Support dual-stream, Triple-stream support H.264/MJPEG/H.265, support multi-level video
quality configuration, and support real-time video output resolution 1080p, 960p and 720p
● Support multiple network protocols, IPv4/IPv6, HTTP, HTTPS, 802.1x, Qos, FTP, SMTP, UPnP,
SNMP, DNS, DDNS, NTP, RTSP, RTP,
TCP / IP, DHCP, PPPoE
6. IR Function
● Mini. Illumination 0Lux
● Adopt array IR, low consumption, IR distance 150m
● IR LEDs and zoom auto match
● Support NFS
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● Built-in heat treatment and defog systems
● Constant current circuit design, IR LED life >30,000 hours

3.2 Function Instruction
● Focus/Rotate Auto Match
Speed Dome can auto adjust pan and tilt rotation speed depending on the focus distance.
● Preset Position Setting and Calling
Preset function means the speed dome can memory current pan/tilt angel, focus, zoom, ect.
When need, it can be called upon directly. Our speed dome support up to 255 preset positions.
● Auto Scan
Users can set the left and right boundaries by control keyboard. Then speed dome can scan
between it. It can set up to 8 groups scan path.
● Auto Cruising
Users can program some preset positions into auto cruising sequence, then the speed dome can
track as it. Each cruising tracks has 32 preset positions.
● Pattern Tour
Speed Dome can memory 180s running path. When start pattern tour, speed dome can track as
recording path. It supports 4 groups pattern tour.
● Guard Location
The dome will rotate back to preset position after a period of vacant time.
● Power-off Protection
Speed dome can resume operation status before the power-off, no data loss.

3.3 Specification
Model
HD IP IR Speed Dome

Specification
Sensor
Camera
Pixel

1.3M:IMX225-1/3”

2M:MN34229-1/3”

3M:IMX123-1/2.8”

CMOS

CMOS

CMOS

1.3M

2.1M

3.2M
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Image

Color:0.5 Lux @ (F1.6,50 IRE,ICR close)
B/W:0.095 Lux @ (F1.6,50 IRE,ICR open)

Resolution
Resolution
White Balance

≥720TVL

≥1000TVL

≥1400TVL

Auto / Semi-auto/Sunshine/Daylight Lamp/Warmlight Lamp/F
ilament Lamp/Nature Light/Lock White Balance/Manual

GC

Auto /Manual

S/N

>50dB

Noise

3D&2D

Reduction
WDR

Support

Electronic

1/1 ---1/100000s

Shutter
Day/Night

Auto ICR

Focus

Auto / Manual/ Semi-auto

Focal Length

5.4～97mm,20X

5.2～98mm,20X

4.6～152mm,33X

Zoom

3S

5S

5S

50.2°-2.9°

55.8°-3.2°

60.8°-2.08°

Near Distance

10～50mm

100～150mm

100～150mm

Iris

F1.6 ～F2.7

F1.5 ～F3.0

F1.6 ～F4.8

Horizontal
Lens

Angle

Horizontal

360°continuous rotation

Rotation Range
Horizontal

0.1°～160°/s（stepless speed）

Speed
PTZ

Vertical

-16°~90°auto flip

Rotation Range
Vertical Speed

0.05°-120°/s

Preset

500

Auto Cruise

16 group, each group can set 32 preset
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Auto Scan

Support track, horizontal, vertical, frame, whole view and random
scan

Guard Location

Link preset/scan/cruise/pattern

Power off

Support

Memory
Position
On/Off

Information
Display
IR Distance

150m

IR Angle

Zoom matching, far/middle/near

IR
Image

1280×960

1920×1080

2048×1536

resolution
50Hz:25fps(2048×15

Frame rate

50Hz: 25 fps

50Hz:25fps(1920×10

36)

(1280×960)

80)

25fps(1920×1080)

25 fps

25fps(1280×960)

25fps(1280×960)

(1280×720)

25fps(1280×720)

25fps(1280×720)

60Hz: 30 fps

60Hz:30fps(1920×10

60Hz:30fps

(1280×960)

80)

(2048×1536) 30fps

30 fps

30fps(1280×960)

(1920×1080)

(1280×720)

30fps(1280×720)

30fps(1280×960)
30fps(1280×720)

Network

Video

H.264/MJPEG/H.265

Compression
Audio

G711A/G711U/G726/ADPCM/AAC

Compression
Network

IPv4,HTTP,HTTPS,802.1x, FTP,SMTP,UPnP,SNMP

Protocol

DNS,DDNS,NTP,RTSP,RTP,TCP/IP,DHCP,PPPoE

Preview

Max 20ch

Channel
Stream
Authority

Triple
32 users, 4 level: administrator, browse, browse+control,
browse+control+setup
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Safe Mode

Authorized user name and password, HTTPS encryption; IEEE
802.1x network access control, IP address filtering

Audio Input

Support

Audio Output

Support

Network

10M/100M

TF Card

Support

Program

Support standard Onvif

Interface

Browser

IE8,IE9,IE10,Chrome8+,Firefox3.5+

Power

AC24V 40W max

Working
-40 ℃-65℃

Temperature

Humidity<90%

and Humidity
General

Protection

IP67/TVS 4000V lightning protection

Level
Dimensions

Ф230（mm）*350（mm）

Weight

4.8kg
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Model
HD IP Starlight Auto-tracking IR Speed Dome

Specification

1/1.8" Sony Progressive Scan

1/1.8" Sony Progressive Scan

CMOS

CMOS

Pixel

2.1M

2.1M

Image
Resolution

Color: 0.002 Lux @(F1.5,AGC ON)
Black&White:0.0002Lux @(F1.5,AGC ON)
0 Lux with IR"

Resolution

≥1000TVL

Sensor

White Balance
Camera

Auto / Semi-auto/Sunshine/Daylight Lamp/Warmlight Lamp/F
ilament Lamp/Nature Light/Lock White Balance/Manual

GC

Auto /Manual

S/N

>55dB

Noise

3D

Reduction
Support

WDR
Electronic

1/25-1/100000S

Shutter
Day/Night

Auto ICR

Focus

Auto / Manual/ Semi-auto

Focal Length

6-180mm,32X

6～210mm,44X

Zoom

5S

5S

61.2°~2.32°

60°-2°

Near Distance

10～100mm

10～100mm

Iris

F1.5~F4.3

F1.5~F4.8

Horizontal
Lens

Angle

Horizontal

360°continuous rotation

Rotation Range
PTZ
Horizontal

0.1°～160°/s（stepless speed）

Speed
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Vertical

-16°~90°auto flip

Rotation Range
Vertical Speed

0.1°-120°/s

Preset

500

Auto Cruise

16 group, each group can set 32 preset

Auto Scan

Support track, horizontal, vertical, frame, whole view and random
scan
Link preset/scan/cruise/pattern

Guard Location
Power off

Support

Memory
Position
Information

On/Off

Display
IR Distance

150m

IR Angle

Zoom matching, far/middle/near

IR
Image

1920×1080

resolution
50Hz: (1920×1080) 25/50fps
(1280×960) 25/50fps
(1280×720) 25/50fps

Frame rate

60Hz: (1920×1080) 30/60fps
(1280×960) 30/60fps
(1280×720) 30/60fps

Video
Network

H.264/MJPEG/H.265

Compression
Audio

G711A/G711U/G726/ADPCM/AAC

Compression
Network

IPv4,HTTP,HTTPS,802.1x, FTP,SMTP,UPnP,SNMP

Protocol

DNS,DDNS,NTP,RTSP,RTP,TCP/IP,DHCP,PPPoE

Preview

Max 20ch

Channel
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Stream
Authority
Safe Mode

Triple
32 users, 4 level: administrator, browse, browse+control,
browse+control+setup
Authorized user name and password, HTTPS encryption; IEEE
802.1x network access control, IP address filtering

Audio Input

Support

Audio Output

Support

Network

10M/100M

TF Card

Support

Program

Support standard Onvif

Interface

Browser

IE8,IE9,IE10,Chrome8+,Firefox3.5+
AC24V 45W max

Power
Working

-40 ℃-65℃

Temperature

Humidity<90%

and Humidity
General

Protection

IP 67/TVS 6000V, Lightning/ Surge 4000V Protection

Level
Dimensions

Ф230（mm）*332（mm）

Weight

5.1kg
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Chapter 4 Installation Guide
4.1 Preparation
1. Tools:
Please prepare the necessary tools according to specific situations

2. Check installation space and address
Check the space is enough to install the speed dome. The wall must be thick enough to install
the expansion screws and can bear 4 times the weight of the dome camera itself.
3. Please well keep the whole package
After open the package, please well keep them in case need to return to manufacturer if any
problem.
★Note:The non-original package may lead to damage during the transportation.

4.2 Installation
The speed dome supports four types installation as following:
1:Wall mount and dimension:

15

258

109
85

139 163

Ø45

Ø9

Wall Mount Bracket Dimension
2:Pedant mount and dimension:

236

Ø45
Ø118

Ø90
Ø9

Pedant Mount Bracket Dimension
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3:External corner and dimension
85

139 164

M8
176

104

120

External Corner Bracket and Dimension
4:Pole mount and dimension:
120

139 165

M8

44

Pole Mount Bracket and Dimension
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4.3 Interface Instruction

Speed Dome and Bracket Interface Dimension
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4.4 Installation Procedures (Take Wall Mount as Example)

Figure 1
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Figure 2
Steps:
Remove the wall mounting bracket and speed dome, and lead the cable through the bracket and
set aside to the right position. Aligned the screw holes of speed dome to that of bracket, and use
M6 screws to fix. (as Figure 1)
Mark the drill holes position on wall with ink pen for bracket installation, then drill holes and
punch the expansion screws in, then fasten the bracket with M8 screws as Figure 2.
Description:
1) The wall must have sufficient load-bearing capacity.
2) Outdoor installation shall be completely sealed moisture; leads cable should closely along the
bracket wiring as Figure 1.
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4.5 External Cable Connection Instruction

Power Cable:AC24V;
Network: Connect computer or other devices
Audio Cable: Audio input and output can connect mic and speaker
Alarm Cable:Connect external alarm devices;

Note: Please refer to labels on the cables

Chapter 5 WEB Instruction
5.1 System Requirement
The IP speed dome web settings support Windows XP, Win7 system, please make sure right
installation and setup of following items:
(1) Display resolution: 1024 * 768 or higher, color: High Color (32-bit).
(2) Please make sure the Windows system install the necessary character style.

5.2 Built-in Web Instruction
When using the network video products for the first time, an ActiveX control is needed. Note:
please use IE browser of windows and make sure the version above 6.0. Do not use any other
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browser except Firefox, Google.
(1) Login IP address and enter to ActiveX download interface.
(2)Download ActiveX and click 【Run】to install

5.3 Log in
Camera default IP address is:192.168.1.2,please make sure computer and IP camera in the
same IP address area.
You need to download Active X plug when first time to use.

5.4 Preview
Descriptions of live view page
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5.4.1 Live View

Descriptions of live view parameters and toolbar
Icon

Description

Icon

Description

Major stream

Intercom on/off

Minor stream

Full screen

Third stream

Audio on, volume
adjustment and mute

Screen lock

Area Exposure

Screen adapt to current

Area Focus

resolution
Manual recording on /

Digital Zoom

off, and default storage
path is
D\NetVideoBrowser\
Manually capture, and

Manual Tracking

default storage path is
23

D\NetVideoBrowser\

Sound alert button

Laser button

Alarm elimination
button

QR code button

(1)All functions will be available after clicked icons.
(2)When stream type is <Pure Video>,audio preview is invalid.
(3)Talkback only support one user at one time, please close this function is the talkback is finished,
to avoid other user to use this function.
5.4.2 PTZ control

Direction button is used to control PTZ moving direction, button
in the center is to call Scan1

Speed bar is designed to adjust rotation speed, "+" means fast,
"-" means slow
Zoom in /Zoom out
Focus buttons,"-" mean focus on near side, "+"means focus on
far side
Manually adjust iris.
Preserved for future functions
Wipper
Click to enable Defog function
Click to enable High Light Control function
Click to enable WDR function

5.4.3 Preset position
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Features: Preset is to save a quick position for PTZ, it contains the horizontal and vertical angle
and camera focus etc.

Search the target preset number.

Setup preset position.

Call the preset position.

Delete the preset position.
Call and Delete functions are only available for existed presets.
5.4.4 VCA Action

<One-key watching>: Click the button of One-key watching and the current scene will be set as
the watching preset (default preset 1). Start the watching function at the same time.
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Mode Selection：Select target mode, <Auto Cruise>,<Auto Scan>,<Pattern>, < Intelligent
Scene >

<Call> call automatic action
<Set> set automatic action
5.4.5 Video parameter
(1)<Default> to resume the default settings.
(2)According to network situation you can choose preview mode from <Low
bandwidth>, <High quality>
Brightness
Contrast
Satruation
Hue

For details, see the configuration page
5.4.6 right-hand button

Click the right-hand button on the video image and the following function options
will be ejected out:
<Disconnect>: Disconnect the video code stream connected currently.
<E-zoom>: The function of it is the same as the digital zoom button of the preview
interface.
<3D locate>: Adjust the scene needing to be monitored into the video center through
the mouse click control.
<Flip>: Control the video image to reverse for 180 degrees.
<Snap Shot>: Cut out the current preview image and store it into the memory card of
the equipment. It is applicable to the equipment with the memory card installed at the
front end.
<Defog>: Start the automatic defogging and after the defogging, the function will be
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closed down automatically.
5.5 Playback
On the playback interface, The user can view the video file on specific date. While the
operation of snapshot, film editing, etc. is available.Read the following table for the basic
operation:

Stop recording
Speed down in 1/2X,1/4X,1/6X and 1/8X
Play/Pause
Speed up in 2X,4X,6X and 8X
Playback by frame
Audio on/off
volume adjustment and mute
Click browse button to select target video file
Capture, and default storage path is
D:\NetVideoBrowser\
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Clip video files, and default storage path is
D:\NetVideoBrowser\
Single screen
Playback in 4 screen at the same time

Double click the screen or click

to enter full screen

status. In full screen, double click or enter <Esc> to quit
full screen
playback switch mode

Click the date in calendar to choose the files according to
conditions

Mode switching : Playback includes time shaft mode and document mode, switching by clicking
.

means in the document mode, and

hows in the time shaft mode.

In time shaft mode user can drag to choose recording files, and then click

to play, click

to zoom out the time shaft and click
to zoom in.
In document mode user can operate it according to document type, recording type, and remote
enquiry. The button functions as below :
Icon

Description
Select file type
Select Video type
Check to search remote files
Jump to first page
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Jump to previous page
Jump to next page
Jump to the last page
Download recording files
Download files into FTP server
Preview download status

5.4 Log

(1)<Channel No> Select target channel
(2) <Log Type>
All/system/warning/alarm/operation/user/others
(3) <Start Time> Select start date and time.
(4) <End Time> Select end date and time.
(5) <Query> Get a log list.
(6) Check logs by <First Page><Pre Page><Next Page><Last Page> and <Jump To>target
page.
(7)<Export Current Page> to export logs, and default save path is D\NetVideoBrowser.
(8)<Export All Page> to export all the pages query, and default save path is D\NetVideoBrowser.
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Chapter 6 Configuration

6.1 Audio Video Set
6.1.1 Stream Set
General Set
(1) <Stream Type><Audio Video> / <Pure Video>.
(2)<Resolution>4CIF/VGA/720P/960P/1080P/QXGA.
(3) <Bit Rate> show stream rate for the video, unit is Kbps. When choose <Static code rate> ,
<Bit Rate> stand for actual rate of the stream. When choose <Dynamic code rate>, <Bit Rate>
show the max stream rate, range from 32 ~ 8000Kbps.
(4) <Frame Rate>1/5/10/15/25/30fps optional.
(5) <N/P Mode> Select <PAL> or <NTSC>.
(6) <Priority>
<Frame Rate> Fluency first.
<Quality> Video quality first.
(7) <Video Quality> only be activated when choose <Dynamic code rate> in <Encoding Mode>.
<Video Quality><Best>,<Better>,<Good>,<Normal>,<Poor>, The better quality the more stream
and bandwidth occupation.
(8) <I-Frame Interval> To set the interval time for each two I frame. (I frame is the key frame in
the video stream).
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(9)<Encoding Mode>
<Constant Bit Rate> In constant bit rate mode, there is little variation in video data volume, the
bandwidth is stable.
<Variable code rate> In variable bit rate mode, video data volume varies according to the
complex of video image. Single scene can save more bandwidth.
(10)<Smooth Video Streaming> Setting the ratio of I and P frame. More smooth, more fluent in
dynamic scenes, and more clear of the video in static scenes.

Advance Set
(1) <Video Encoding> <H.264>,<H.265> and <Motion JPEG>.
(2) <S+> adaptively encode according to the specific scene, further improve the compression
performance and reduce the storage space.
(3) <Extended Code> Available when selected <H.264>, there are <baseline>, <main profile>,
<high profile> for selection.
(4) <Encrypt Type> Add password for the channel.
<Encrypt Password> Enter password.
<Password Confirm> Confirm the password. Click <Save> to enable.
(5) <Electronic Image Stabilizationt>Select <Disable> or <Enable>.
(6) <SVC>Select <Disable> or <Enable>.
(7) <Save> Save and enable the setting.

Stream Set -Export
<Export> backup the configuration file.

Stream Set -Import
<Import> import the backup file for parameter configuration.

6.1.2 Audio Set
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(1)<Audio Encoding> select audio compression type.
(2)<Audio Sample Rate>
<8k>,<32k>,<64k> optional.
(3)<Audio Control Type>
Select<LineIn>or<MicIn>, When the input source signal is weak, select <MicIn>, when the input
signal source is strong, select <LineIn>.
(4)<Volume Value> Voice volume setting
(5)<Audio Denoising> Denoising level setting, default value is 1, the larger the number is, the

higher the audio denoising level is. Audio denoising function is shut down at 0.
(6)< Audio export type > Select the audio output type in the drop-down box: <Built-in speaker>,
<External sound source>, <Close>.
(7)<Save> save and enable the setting.
Note: some models need reboot after saving the setting.

6.1.3 Key Region
<Key Region> To have better image quality for some regions on the video, there are 7 regions
settable for 1st Stream and 2nd Stream.
(1) <Start to Draw >
Use the mouse to draw the key region on the video.
(2) <Delete Region>
delete the drawn regions.
(3)<Selezione Tipo>Select<Fixed Area>or<Rilevamento Dinamico>
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Dynamic tracking mode selected, Dynamic tracking in key zone is available.
(4)<Upgrade Level><Best>,<Better>,<Good>,<Normal>,<Poor> the higher the level, the
better the details.
(5)Click<Save> to enable.

6.2 Dome Set
6.2.1 Image Set
Set video image parameter in this page.
The system provides 4 video templates for
different application, all the video parameter
can only be revised and saved in the template.
(1) <Current> Select current template.
(2)<Name>show the name of the current
template, it can be revised.
Image Adjustment
(1)<Brightness>
Range from 0 to100.
(2)<Contrast>
Range from 0 to100.
(3)<Saturationt>
Range from 0 to100.
(4) <Hue>
Range from 0 to100.
(4) < Sharpness >
Range from 0 to255.
Exposure Set
(1)<Auto Expoure Speed>
Range from 0 to100. The larger the value, the faster the exposure speed
(2)<Expouse>:<Auto><Manual><Shutter Priority><Iris Priority>
(3)<Max Gain Set>:The

maximum gain value adjustment can modify the image
brightness compensation under the low luminance; the higher the gain value is, the
higher the improvement of the brightness will be, but the larger the noisy point will
be.
(4)<Target Brightness>: The brightness of the video image can be set by adjusting the
target brightness. The larger the value is, the higher brightness of the video
monitoring image will be, and the larger of the noisy point will be under the low
luminance.
Focus Set
(1)<Focus Mode>:<Auto><Manual><Semi-auto>.

Under <Semi-auto> mode, one PTZ
action triggers one focus, and there is no automatic focusing when the same scene
image changes.
(2)<Min Focus Disance>: The minimum focusing distance can be set, and it can be set
as 6m for the outdoor large-scale scene and 1.5m for the indoor scene.
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Smart IR
<Smart IR>:Under the infrared condition, this function can prevent nearby objects from
overexposure due to the infrared opening of the dome camera.
Backlight Set
<WDR><Close><Blacklight Compensation><WDR

Auto><WDR Manual> In BLC mode,

check Backlight Set, then select target in the preview window on the left. can effectively solve the
dark foreground target due to the underexposure.
<HLC>:<ON><OFF> Hard light can be restrained by turning HLC on. The HLC level is adjustable.

When there is strong light, this function can suitably inhibit the strong light and make the video
image clear. The strong light inhibition level can be adjusted according to the actual scene.
White Balance
<Auto>,<Semi-auto>,<Sunshine>,<Daylight Lamp>,<WarmLight Lamp>,<Nature
Light>,<Lock White Blance>,<Manual>.When selected<Manual>,there will be 2 sliding blocks
to set the white balance, R stand for red gain and B stand for blue gain.
Image Enhancement
<Image Style>:<Self-adaption><Nature><Bright><Gentle><Bright-coloured>
<Indoor/Outdoor>:<Indoor><Outdoor>
<Defog>:<Off><On>
<Digital Denoise>:<Close><Ordinary Mode><Exper Mode>. The advanced 3D image noise
reduction technology can effectively reduce the image noisy point and make the image softer and
more exquisite. The noise reduction includes the ordinary mode and expert mode.
<Denoise Level> range from 1~255，The higher the level, the smaller the grain, and accordingly
more likely to have tails on video.
< Save>to save and enable the setting.
< Default>to recover the defaults setting for the target template.
6.2.2 Schedule

The Schedule can be used for day and night, and the equipment can switch the template
automatically according to the external environment..
<Schedule> has Export and Import function, operation is the same as < Stream Set >.
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6.2.3 D/N Set
< Color to B/W Set >: It can be set as night, daytime, timing and auto. Under the auto mode,
day-night image will be switched automatically.

<Sensitivity>: Under the auto mode, the sensitiveness of day-night switching can be set as
low/medium/high.
< Sunrise Time >: Under the timing template, the timing from black to color can be set.
< Sunset Time>: Under the timing template, the timing from color to black can be set.
6.2.4 Basic Set

6.2.4.1 Basic
Basic Information
<Auto Flip Enable> Enable for 0~180°, disable for 0~90°.
<Preset Freeze Enable> On/off preset freeze. The image won’t be switched until the preset

adjustment is done.
<Enable Digitial Zoom> On/off digital zoom. When it is on and optical zoom is maximum,

digital zoom will be enabled
< Enable Preset Snapshot > On/off snapshot on preset, when it is on and preset is enabled, the
snapshot will be saved in camera
< Enable Proportion Zooming > on/off proportion zoom, when it is on, the speed will be
adjusted to the zoom value, vice versa.
< Enable Scan Record > on/off scan recording, when it is on, it will be recorded when scanning
and the recorded file will be saved in camera.
<Enable Mode Record > on/off pattern path recording, when it is on, it will be recorded when it
is in pattern path and the recorded file will be saved in camera.
<Tilt Angle Adjustment> Set the tilt angle for speed dome camera, range from “0”to“-11” degree.
High speed dome: 0 to -15，V3 IR speed dome: 0 to -16
<Control Speed>
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Set limit for the max operation speed, high/medium/low for selection.
<Zoom Speed Level)> Zoom speed level setup, the default is middle, the higher the level is, the
faster the manual zoom speed.
<Temperature Control Mode><Auto>and<OFF>、<DEFOG>
<Auto Stop-time (s)> Set the time period for the speed dome camera to stop PTZ movement
since the last operation. It can be set to be 5/15/30/60s.
<Preset Speed> Set the preset speed for speed dome camera, there are high/medium/low for
selection.
< P/T First >：Ethernet and RS485 interfaces. Check PTZ priority as required.
< Priority delay time(s)>：Delay time between two modes. For example: If the delay time is set
as 30s, when switching from Ethernet to RS485, speed dome cannot be controlled within
30s.
<Standby Action> It is to define the action of speed dome camera when it is idle. There are 4
options preset#1, scan#1, cruise#1 and pattern#1.
<Standby Time（s）> enable standby time setting. There are 30s,60s,300s,600s and 1800s for
selection.
< Power-off memory mode > Automatically save the time and PTZ setting when power is off.
When it is on, PTZ speed dome will be in the last saved setting.
<save> save and enable all the setting.

6.2.4.2 Title
<Title Type> Preset, Scan, Cruise, Pattern
and Zone No.
<Title No.> Preset number range from
1-32, Scan number range from 1-8, Cruise
number range from 1-16 Pattern number
range from 1-8, Zone Number range from
1-8.
<Title Name>Set title name.
<Dwell Time> Title display on the screen,
options 2s,/5s/10s/disappear/keep.
<Display Coordinate Direction> check
to display the movement coordinates.
<Display Title Background> check to display title background.
6.2.5 Motion Set
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6.2.5.1 Preset
<Preset No.> The dome camera can support 500 preset totally, wherein the non-special preset
includes 1-64 and 100-500, and the user can set these
preset..
<Focus Mode> Focus mode for preset can be
auto/manual.
<Set> Move to target position and press <Set> to save
as preset position.
<Delete> Delete the target number of preset position.
<Call>Speed dome camera will move to the target preset position.
6.2.5.2 Cruise
<Cruise No.> Speed dome camera supports 8 cruises,
number from 1-8
<Cruise> show how many presets in the cruise.
<Preset> Only preset number 1-64 and 100-255 are
available, click <Add> to add the preset into cruise
list.
<Stay Time(S)>Set interval time between two presets,
rang from 1-60 seconds.
<Add>Add presets into cruise list.
<Delete>Remove preset from the cruise list.
<Call>Activate the speed dome to move follow the presets in cruise list.
6.2.5.3 Scan
<Scan No.>The speed dome supports 8 Scans,
number from 1-8
<Scan Type>Pan Scan, Auto Scan, Frame Scan,
Random Scan, Tilt Scan and Spiral Scan.
<Scan Speed>Set speed for Pan Scan, Auto Scan, Tilt
Scan, Full Scan and Spiral Scan.
<Border 1>Left border of the Scan.
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<Border 2>Right border of the Scan.
<Call>Activate scan movement of the speed dome.
6.2.5.4 Pattern
<Pattern No.>The speed dome camera supports 8
pattern tour, number range from 1-8.
<Used(%)> Show percentage used for operations in
one pattern tour.
<Left Time(s)> Show the time remaining in the
pattern record process. (The speed dome camera
supports up to 180s)
<Record> Start pattern tour recording
<Delete> Delete the target pattern.
<Call> Activate the speed dome camera to move following the pattern tour.

6.2.5.5 Zone No.
<Zone No.>The speed dome camera supports 8
zones, range from 1-8.
<Left Border> Move the speed dome
camera to the target position and
set it as the left border of the zone.
<Right Border> Move the speed dome camera to the target position and
set it as the right border of the zone.
<Delete>Delete the target zone.
<Set Origin>Move the speed dome camera to the target position and set it as original point of
the coordinate.
<Set North>Move the speed dome camera to the target position and set it as north direction of
the coordinate.
6.2.5.6 Enable Limit
<Enable Limit.> The movement of PTZ will be
limited in specific area when it is checked.
<Limit Status> showing if the limit status is on or
off.
<Left Border> Hit the button, there will be
assistance message on the preview window on the left showing how to set up up-and-down,
and left-and right border. Drag the up and down border to the same location to skip the
vertical border setup.
<Delete> Delete border setting.
6.2.6 Motion Schedule
Activate different motion (Presets, Scan, Cruise and Pattern) for different time period.
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<Enable> Enable the setting.
<Start Time>Start time for the motion.
<End Time>End time for the motion.
<Action> Set the functions executed in the current time period as: None, preset, scan, cruise,
mode path and alarm output..
<Action No.>Motion number, Preset 1-8, Scan 1-4, Cruise 1-4, Pattern1-4.
<All>Enable every day in a week, including Saturday and Sunday.
<Apply>Click to copy the configuration to the selected day.
<Save>Save all the setting.

6.2.7 Fill light setting

For the <Mode>, Select <Infrared> and < White LED and laser control> mode according to the
actual demand;
< White LED Control Mode>: The white-light sources control mode includes automatic, manual
starting and automatic closing.

< IR Control Mode>: The infrared lamp control mode includes automatic, manual starting and
automatic closing.
< Zoom Match>: When selecting the <ON> mode, the brightness and power of infrared lamp are
matched with the camera irradiation distance.
<Near Lamp Brightness> Disable zoom match, set the Near lamp brightness level, range from 0
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to 10.
<Far Lamp Brightness> Disable zoom match, set the far lamp brightness level, range from 0 to
10.
<Save> Save all the setting.
Notes:
1.

the light distance for white light lamp is 30 meters, when the variable magnification is over
30 meters, turn on the white light lamp manually to fill light is not recommended.

2.

For the model of the white light lamp, indoor and outdoor monitoring, if the near scene (2 to
3 meters) has a large reflective object environment, it is recommended turn off the white
light lamp to avoid the repeated turn on/off of the light supplement lamp caused by the
strong light reflection that will affect the image effect.

6.2.8 Remove Config
In the configuration clear interface, including select all, clear all preset, all cruise route, all
scanning, all location limitation settings, standby operations, all mode path, all regional
instructions, select the items to be cleared, click the clear button to clear the corresponding PTZ
configuration.
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6.4 Early-warning setting

In the Early-warning setting interface, the user can select the Early-warning plan according to the
actual situation or preference. The dome camera has 4 plans for selection, and also provides the
user-defined plan.
When the user selects the user-defined plan, the selected scene can be set, including the rule name,
trigger target, deployment time setting, linkage type and others; after saving the finished settings,
click next step, and it will be linked to the cruise setting interface.

< Link Type >: The alarm output, video recording, snapshot, audio, laser, white light , linkage
tracking can be selected, and the selected items will come into operation after being checked.
< Output Port >: When setting the linkage alarm output, select the appropriate output port
according to the needs.
<Channel selection>: When setting the linkage snapshot and linkage video recording, select the
appropriate channel according to the needs.
<Sound>: When setting the linkage sound, the user can select different <Alarm sound> or
<User-defined> audio; the <User-defined> audio can be modified by the supporting tools in the
help document -> download tools.
When <Play> the linkage sound, after selecting the <Alarm sound>, click the play button for local,
remote audition (need to turn on the built-in loudspeaker) to confirm the needed alarm sound.
Description:
1.After the laser is turned on for continuous 300 seconds, the laser will be turned off
automatically.
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2.When selecting linkage tracking, set the tracking rate. By adjusting the angle and magnification
to determine the target screen in the need to monitor an appropriate ratio, the recommended target
screen height of 1/2 or more. , Click to set the tracking rate.

6.3 VCA
6.3.1 Alarm Info
This page is just used to display alarm info when you success to configure.
<Reset>Clear alarm numbers of the VCA rule.
<Clear>Delete all the alarm information in list.
The alarm information statistic box can display the current alarm information, and when double
clicking the name of the images, the snapshot information of the alarming can be reviewed.

6.3.2 Scene Set
<Behavior Analysis> check to enable behavior
analysis, including Tripwire, Perimeter, Items Abandon,
Items Lost, Loiter, Running, Crowd, Parking.
Notes: If check <Linkage Tracking>, it will allows
Tripwire/Perimeter to activate auto-tracking.
<Save Scene> click to activate settings.
<Rule ID> make the rule numbers for behavior
analysis. Support up to 8 rules in the same scene at the
same time.
<Valid> activate the rules and start setting.
<Rule Name>Give a rules name(max to 16 characters).
<Rule Clear>clear current rule.
Description: The algorithm above the transverse line:
Behavior Analysis, Plate License Recognition, etc. It can be
enabled individually. The algorithm below the transverse
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line can work with the algorithm above the transverse line simultaneously.

6.3.2.1 Behavior Analysis
Below are setting operation for different type of analysis after Selected <Behavior
Analysis>:
(1)Event Set --- Tripwire/Perimeter/Double Tripwire
<Detect Mode> For <perimeter> detection, include <Intrusion>/<Enter>/<Leave>.
<Intrusion> alarm when object come in/out.
<Enter> alarm when object come in.
<Leave> alarm when object go out.
<Max time interval> Set up the maximum time interval, which

shows the time interval to pass through two rule lines continuously
<Min time interval> Set uo the minimum time interval
<Perentage> The proportion of the width of the target in the
whole picture.
<Show Alarm Count>show total alarm times.
<Show Alarm Rule>show defined tripwire/perimeter on video.
<Display Target> Checked to show target frame
<Two-way

Alarm>when

selected

<Tripwire>,

choose

the”two-way alarm”, then two directions cross will both trigger alarm.
<Rule Clear>clear current rule.
<Save>Save and enable the VCA setting.
After clicking the save button, click the next step, and it will link to the alarm setting interface.
<Linkage Tracking> or <Panorama Tracking>
Tips: <Linkage Tracking> option is only available when
you check <Behavior Analysis>
< Arithmetic > configure <Intelligent Tracking>
<Longest Track Time> Set time limitation (seconds) how
long the PTZ follow the object. And then it will go back to
standby position.
When selecting linkage tracking, set the tracking rate. By
adjusting the angle and magnification to determine the
target screen in the need to monitor an appropriate ratio,
the recommended target screen height of 1/2 or more. , Click
to set the tracking rate.
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(2)Event Set ---Object Abandone
1. Select the rule number, and name the rule name; select to enable the
rule
2. Draw the item left over area and click <Start to draw> button to draw
the area. Click the left mouse button to draw the turning point or end
point of the line and click the right mouse button to finish the drawing
3. Set the alarm time: it means that when the time of the target under
the lost state reaches the alarm time, it will trigger the alarm.
4. Set the sensitivity: the greater the value, the higher the sensitivity
will be.
5. Set whether to display the alarm statistics, alarm rules and the target
or not.
6. After clicking the save button, click the next step, and it will link to the alarm setting interface.
(3)Event Set ---Missing Object Detecting
1. Select the rule number, and name the rule name; select to enable the
rule.
2. Draw the item left over area and click <Start to draw> button to draw
the area.
3. Set the alarm time: it means that when the time of the target under
the lost state reaches the alarm time, it will trigger the alarm.
4. Set the sensitivity: the greater the value, the higher the sensitivity
will be.
5. Set whether to display the alarm statistics, alarm rules and the target
or not.
6. After clicking the save button, click the next step, and it will link to the alarm setting interface.
(4)Event Set ---Loiter
1. Select the rule number, and name the rule name; select to enable
the rule.
2. Draw the wandering area and click <Start to draw> button to draw
the area.
3. Set the alarm time: it means that when the time of the target under
the wandering state reaches the alarm time, it will trigger the alarm.
4. Set the sensitivity: the greater the value, the higher the sensitivity
will be.
5. Set the minimum area: it means that when the movement area of
the target (percentage of the area) in the detection area reaches the
minimum area, it will trigger the alarm.
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6. Set whether to display the alarm statistics, alarm rules and the target or not.
7. After clicking the save button, click the next step, and it will link to the alarm setting interface.
(5)Event Set ---Running
1. Select the rule number, and name the rule name; select to enable
the rule.
2. Draw the running area and click <Start to draw> button to draw
the area.
3. Set the minimum moving distance per second: it means that when
the moving speed (percentage per second) is great than the minimum
moving distance, it enters the running mode.
4. Set the sensitivity: the greater the value, the higher the sensitivity
will be.
5. Set the targets that trigger the alarm, and they can be set as <All>,
<Vehicle>, and <People> respectively. <All> means all moving objects.
6. Set whether to display the alarm statistics, alarm rules and the target or not.
7. After clicking the save button, click the next step, and it will link to the alarm setting interface.
(6)Event Set---Parking
Draw the Parking area and click <Start to draw> button to
draw the area.
<Alarm Time(s)> time to activate alarm.
<Sensitivity> bigger value, higher sensitivity
<Speed Threshold> The arlarm will be triggered once

the target is out of the range of motion
<Show Alarm Count> show total alarm times.
<Show Alarm Rule> show the defined area on screen.
<Display Target>checked to show target frame
<Save> save to enable.
(7)Event Set---Early Warning
1. Select the rule number, and name the rule name; select
to enable the rule.
2. Draw the Early Warning area and click <Start to draw>
button to draw the area.
3. Set the sensitivity: the greater the value, the higher the
sensitivity will be.
4.<Stay time> Dome will give alarm when the object stays
in detection area for a certain time you set here.
5. Set whether to display the alarm statistics, alarm rules
and the target or not.
6. After clicking the save button, click the next step, and it
will link to the alarm setting interface.
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6.3.2.2 Face Detection
This function will enable speed dome to recognize
people’s face and snapshot and save face picture
automatically.
(1)Check <Face Detection>
(2)Click <save scene> to start setting
(3) Draw the face detection area and click <Start to
draw> button to draw the area.
(4)<Max Face Size> <Min Face Size> setup target
face size percent in target region.
(5)<Sensitivity> Set the sensitivity: the higher the
value is, the higher the sensitivity will be; when the
detection rate is promoted, the false detection will
also increase.
(6)<Save> save to enable. Then click the next step,
and it will link to the cruise mode interface.
6.3.2.3 Demographics
This function will enable speed dome to count the
number of how many people cross the defined line
on screen.
(1)Check <Demographics>
(2)<Arithmetic> choose <People Counting>
(3) Draw the Demographics area and click <Start to
draw> button to draw the area.
(4)<Max Target Size> <Min Target Size> setup
target people size percent in target region.
(5)<Sensitivity> the higher the value is, the higher
the sensitivity will be; when the detection rate is
promoted, the false detection will also increase.
(6)<Save> save to enable. Then click the next step,
and it will link to the cruise mode interface.

6.3.2.4 Crowd Detection
(1)Check < Crowd Detection>
(2)Click <save scene> to start setting
(3) Draw the Crowd Detection area and click <Start to
draw> button to draw the area.
(4)<Alarm Time> Reach the time will trigger the
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alarm
(5) <Sensitivity> the higher the value is, the higher the sensitivity will be; when the detection
rate is promoted, the false detection will also increase.
(6)<Save> save to enable. Then click the next step, and it will link to the cruise mode interface.

6.3.2.5 On Duty Detection
(1)Check < On Duty Detection>
(2)Click <save scene> to start setting
(3)< On Duty Number> Set duty number, support 1 and 2
people
(4) Draw the on-duty detection area and click <Start to
draw> button to draw the area.
(5)<Absences Alarm Time> Detect target leaving reach
the absent time will trigger the alarm
(6)<Sensitivity> Set sensitivity, the bigger value the more
sensitive.It improve detection rate also increase the false
detection.
(7)<Max Distance> <Min Distance> Set the maximum
and the minimum target size, show the target size in the
whole picture.
(8) <Show Alarm Count> show total alarm times.
(9)<Show Alarm Rule> show the defined area on screen.
(10) <Display Target> checked to show target frame
(11)<Save> save to enable. Then click the next step, and it will link to the cruise mode interface.
6.3.2.5 Illegal

parking

(1)Check < Illegal parking >
(2)Click <save scene> to start setting
(3)Draw the illegal parking detection area and click
<Start to draw> button to draw the area.
(4)Draw the non-stop area in the illegal parking
area: one at least and three at most.
(5)Fill in the names of illegal parking area.
(6)Set the no-parking time: it means that when the
time of the target in the no-parking area reaches
the intrusion timeline, it will trigger the alarm.
(7)Set the sensitivity and it can be set as <Low>,
<Medium> and <High>.
(8)<Save> save to enable. Then click the next step,
and it will link to the cruise mode interface.
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6.3.2.6 Video Detection
(1)Check < Video Detection>
(2)Click <save scene> to start setting
(3)< Lens Dignose>< Sceen Switch Dignose>
Check to enable the <lens dignose> and <screen
switch dignose>
(4)<Sensitivity> Set the sensitivity , the bigger
value the more sensitivity.
(5)<Save> save to enable.

6.3.2.7 Audio Detection
(1)Check < Audio Detection>
(2)Click <save scene> to start setting
(3)< Signal Loss Detection>< Signal Abnormal
Detection>

check

to

enable

these

function.

(4)<Sensitivity> Set the sensitivity , the bigger value
the more sensitivity.
(5)<Save> save to enable.

6.3.3 VCA Schedule
Setup VCA activation schedule.
(1)<VCA Enable> Indicate the VCA status of the
current channel.
(2)<Scene Number>select scene number,range
from1to 16.
(3)<Rule ID> Connected to the setup VCA rules in
<Event > When select rule ID, it will bring out setup
information of <VCA Enable>, <Rule Name> and
<Event>.
<Enable> Enable the setting of <Schedule> to setup
the day and time of the VCA activation.
(4)<Schedule> Schedule alarms. 4 time periods
selectable in a day.
<Apply> enable the setting.
(5)<Link Type>
The alarm output, video recording, snapshot, audio, laser, white light can be selected, and the
selected items will come into operation after being checked. In addition to the warning event, the
linkage alarms of all behavior analysis don't support the white light.

Description: After the laser is turned on for continuous 300 seconds, the laser will be
turned off automatically.
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(6)<Save> Save to enable setting.

6.3.4 Cruise Set
Cruise mode used to set the different scenes of VCA cruise.
Theree are <Time Cruise > and <Schedule Cruise> can been
choosed.The up and down button can adjust the cruise order.
<Add>：Add the cruise scene.
<Delete>：Delete the selectedcruise scene.
Timed Cruise
Enable the speed dome to switch between different defined VCA functions, time interval range
from 30~3600 seconds.
Schedule Cruise
Set valid time period for each defined VCA functions.
<Save> Save the cruise setting.

6.3.5Advanced
Scene Parameter
<Resum Time> Set the scene resume time-10s, 30s, 60s,
120s, 300s and enable the VCA scene. It shows the PTZ
resume time from finishing manual control to return
original scene. For example, set the resume time 10s, it
means stopping manual PTZ control to 10S, PTZ back to
the scene automatically.
Object Set
(1)<Scene Number> Select target Scene No.
(2)<Max Target Size> Set upper limit how much
proportion the Object occupy on the screen for
recognition
(3)<Min Target Size> Set lower limit
(4)<Target Confirmed Frame> Adjust the target
formation rate.
(5)<Enable>
(6)<Save> save to enable.
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6.4 OSD
6.4.1 OSD
Camera Title
(1)<Camera Title > Input channel name, then it will show
on screen.
(2) <Customize Position> drag < Camera Title > to the
target position on screen.
(3)<Color> Choose your favorite color.
Date
(1) <Date> Display date on screen.
(2) <Customize Position> drag <Date> to the target
position on screen.
(3)<Color> Choose your favorite color.
(4)<Show Week> Display week on screen
Additional Text
(1)<Additional Text> 5 areas available to put additional
text on the screen.
(2) <Customize Position> drag <Date> to the target
position on screen.
(3)<Color> Choose your favorite color.
OSD Size
< Self-adaptive> Edit OSD size.
<Save> Save all settings.
< Font Type > < Vector > .<Lattice>

6.4.2 LOGO
Add LOGO picture on screen.
Notes logo picture format must
be .bmp, and must be follow the size.
<LOGO File>,<Browse> to select logo picture,
and<Upload>
Notice Device will restart after upload
(1)After restart, select<Enable> to show the
logo on screen.
(2)Enable<Customize coordinate Pos> to
put the logo on the target position on screen
where you click.
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6.4.3 Privacy Mask
Add up to 24 cover areas on the screen.
(1) Draw up the area to be sheltered in the small preview window.
(2) Click <Add area> button.
(3) Shielding magnification: Set up the magnification value, only when the variable magnification
value is greater than the shielding magnification, the private shelter area will display, or it will not
display.
(4) If the user wants to delete the shelter area, click the square frame before the serial number to
select corresponding shelter area, then click <Delete area> button to delete the area.

6.5 Storage Management
Notes: The dome camera doesn't support TF card hot plug, and it is
recommended to do that after the power cut.e Management
6.5.1 Record Policy
Setup recording schedule.
(1)<Record Status> Display current
record status.
(2)Select recording
type(multiple-choice)
<Manual Rec> Check to start recording.
<Alarm

Rec>

Recording

will

be

activated by alarm.
<Continous> Timing recording, 4 time
periods settable for one day.
(3)<Offline Video Recording> When it
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is ON, the device will
follow the schedule of <Task Rec> when offline.
(4)<Save> Save.

6.5.2 Pre-Alarm Recording
<Pre-Alarm Recording> record before alarm, or
continue to record after alarm.
(1)<Pre-Alarm Recording> Check to enable.
(2)< Pre-Alarm Time(5-15)s > Record before alarm.
(3)< Post-alarmtime(10-60)s > Continues to record
after alarm.
(4)<Save> Save all settings.
6.5.3 Storage Set
<Free Disk Space(MB)> Remaining disk space.
<When HDD is full > Select how to handle the record
files when the disk is full.
<Stop Rec> Stop record new files.
<Overwrite> Delete the earliest record files.
< Over write (Exclude Alarm Record Videos)>
Delete the earliest record files except event record files.
<Save>
6.5.4 Snapshot Set
(1) <Timing capture> Enable/Disable timing capture
(3)<Interval> Set how much internval times between
two snapshots.
(4)<Link FTP>snapshot and upload to FTP server.
(5)<Link Email>snapshot and send to target email.
(4)<Save>

6.5.5 Disk Management
<Initialize Disk> format the disk
6.5.6 Net Storage
(1)<Disk No.> Select disk.
(2)<Status> Show current disk status information
(3)<Usage> Shows purpose of disk.
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(4)<IP Address> Setup IP address of <Network Storage>.
(5)<Mapping Path> Setup disk path of mapping.
(6)<Total Size> Shows used and total capacity of
the disk.
(7)<Save>

6.6 Network Management
6.6.1 IP/TCP Network
<DHCP> check to enable DHCP server will
automatically allocate IP address for devices.
<IPv6> Display IPV6 address and subnet mask.
<MTU> Maximum Transmission Unit, range from
500~1500, default value is 1500.
<Ethernet Rate> Select mode and rate of Ethernet
card, default mode is <Automatic Detection>, speed
unit is MB.

Notes: Devices will restart after change <Ethernet
Rate>.
6.6.2 Registration Center
Keep same settings as what you register in DDNS website.

6.6.3 Network Service
DDNS
Keep same settings as what you register in DDNS
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website.

FTP
Make sure to insert the memory card.

PPPoE
Check to enable PPPoE function, enter User name and
confirm password.

NTP
<NTP Server> enter server address.
<Port> enter NTP server port.
<Interval> update interval.

Others
Set Http and Https port, Enable UPnP and SNMP
functions.
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6.6.4 IP Filter
Blacklist
User want to block some IP address,
select<Block the Following IPs>, input the
block IP address and<Add>,<Save>.Max to
add 16 blacklist IP address.
Caution: Please don’t add your own IP
address in blacklist, otherwise you will not be
able to login.
Whitelist
User want to allow only some IP address,
select <Allow the Following IP>, input trusted
IP address, <Add> and <Save>. Max to 16
whitelist IP address.
Caution: Once enable the whitelist function, please make sure to add your own IP address in
whitelist, otherwise you will not be able to login the device.
Cancel blacklist or whitelist
Anytime click<Allow All> and <Save> to cancel all the blacklist and whitelist.
Note: Please restart device after setup blacklist or whitelist.

6.7 User management
6.7.1 Add User
<User name> add user, only English letter and figure
are available.
<Password> only English letter and figure are
available.
<Authority>:
Browse: Can only watch the videos.
browse+ control: Watch video and control PTZ.
browse+ control+ set: Allow all operation except
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user management.
Administrator: All operations available.
6.7.2 Modify password
Select the user you want to modify in the user list, click <Modify Pwd>,input the old password,
new password, password confirmation, then click<Modify>.
6.7.3 Delete User
Select targeted user in user list and click【Delete】 to delete.
6.7.4 Online user
It is selectable to check the login or connection information of the equipment. Select a certain IP
and click disconnect to force the IP to log out.

6.8 Alarm Management
6.8.1 Alarm Input
IP Camera alarm input has port1~8, alarm mode include closed circuit alarm and open circuit
alarm.
<ON>is closed circuit alarm.
<OFF>is open circuit alarm.
<Alaram Output>/<Link PTZ>/<Link Snap> activate alarm device/ PTZ/Snap.

6.8.2 Alarm Output
Alarm output has port 1~2.
<ON>is closed circuit alarm.
<OFF>is open circuit alarm.
<Delay Time> Set the alarm delay time.

6.8.3 Motion Alarm
(1)<Set Motion Detection Area> Check to draw area on
screen.
(2)< Delete Region > Clean drawn area.
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(3)< Sensitivity> set detection sensitivity, range from 0-100, 0 means the highest sensitivity.
(4)<Schedule> setup alarm arm schedule.
(5)< Alarm Output> set alarm activation.

6.8.4 Mask Alarm
Alarm when camera lens is covered.

6.8.5 Email Alarm
(1)<Email Alarm Enable> check to enable sending email after
alarm.
(2)Set sending email information:
<SMTP server> <SMTP port><Email Account><Email Password>
(3)<Email Mode>
(4)Input receive email address, support up to 4 email address.

6.8.6Alarm Server
Set alarm server’s IP address and port number,
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6.9 PTZ Management
PTZ management mode: <Serial Port
Set>and<Protocol Set>
<Serial Port Set>:
<Port Name>,<Baud Rate>,<Parity>,<Byte
Size>,<Work Mode>
<Protocol Set>:
<Channel>,<Port Name>,<Protocol>,<Address>

6.10 Advance
6.10.1 File Location
(1)<Showing frame-rate and bit-stream information> check to display frame rate and bit stream
on video.
(2)Set the save path of record files, snapshot, clips and download files.
(3)<Protocol Type> TCP, UDP or multicast.
(4)IP camera has only one channel, user can choose major stream or minor stream.
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6.10.2 System set
(1) <System Information>Display information
of CPU,Memory and FLASH.
(2) < Version Information >Display <SDK
Version>, <Kernel Version>, <Web Version>
and<Factory ID>.
(3) <Language and Time> Set time zone and
time synchronous
(4)<Daylight-Saving Time>Enable /Disable
Daylight-Saving Time

6.10.3 System Maintenance
(1)<Device Control>
Users can carry out < Basic Recovery>, <
Complete Recovery >, <Reboot>, < Lens
Reset >, < Open / Close remote service >
operations.
(2)<Firmware Upgrade> upgrade new
firmware. (firmware format: .box/.bin)
Upgrade process normally needs a few
minutes until indication for completion.
(3)< Open remote service>: Caution: Remote
servise is design for manufacturer debugging,
it may cause risk on device if this function is on.
(4)<Configuaration In/Out> Export the alarm/VCA/system setting parameters, import selected
files. It will automatically restart after successfully import.
(5)<Auto maintenance>: Set the automatic reboot time of the dome camera to conduct automatic
maintenance.
Caution: Please strictly follow the instruction by technical specialist for firmware upgrade.
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6.10.4 Access Platform
PU Set
User can set the IP address and port number of<Register
Server>,<Heartbeat Server>,<Alarm Server>and VSP’s port
number and VAP’s port number.
<Channel No. >support<Auto Filling
Setting>function.

SIP Set
PU set support 【SIP】protocol setting.

Platform Enabled
<Platform enabled>: Select the platform, check
onvif, 28181, rtsp, CGI, P2P services supported by
the platform (services supported are different for
specific models), and users can set whether

to

activate it on sole discretion or not.

Chapter 7 Simple Problem-solving Methods

symptom
Power on no action,

Possible causes

Solutions

Power supply is damaged or not
enough power
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Replace the power supply

No images,

Power cable fault

Machine is not self
checking

Corrected
Troubleshoot line, measure IP speed dome’s

Line problems

voltage

Network line or switch damaged
Self action properly,
but can’t ping

IP speed dome’s IP address and
PC’s IP address aren’t in same
network segment

Ping

is

Test by IP speed dome connect to PC directly
Change IP address to insure they are in the same
network segment and aren’t conflict.

User name or password error

Check user name or password

Port number error

Check port number

Login account more than limit

Disconnect other client host

Login account more than limit

Connect video by proxy server

Camera is damaged

Check log record

Parameter setting error

Restore the default parameters

working

normally, but can’t
login

No video after login

IP address conflict; MAC address
Image is not stable

conflict; broadcast storm
Network line problem

Check network line
Check CPU utilization, reduce code stream or

PC performance isn’t enough

Image is not stable,
delay,

resolution

Frame rate is low

Change frame rate in more than 20

The network bandwidth shortage

Replace the gigabit switches

Decoder’s

performance

isn’t

enough
IP Speed dome can’t
be controlled

IP

Speed

restart

again

Serial port Settings error

and

Change decoder
Check and change serial port number to “COM2”

Protocol, Baud rate, address error
dome

Check network setting

Check IP speed dome’s protocol, baud rate and
address

Power supply isn’t enough, voltage

Measure IP speed dome’s voltage to insure

isn’t stable

stability
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again

PPPOE dialing failed

Check and change dialing parameter

Camera is damaged

Replace the camera

Parameter setting error

Restore the default parameters

Chapter 8 After-sales Service
The HD Network IR speed dome products, the company offers one-year warranty. Product
warranty, the company provides a free service, but if any of the following circumstances, is
charged fee for material costs work:


Do not operate in accordance with the provisions of the manual



The speed dome damage caused by a case of the lightning strikes, fires and irresistible
natural disasters;



Matching problems arising from poor design to other manufacturers products cause
damage;

Company statement


As we continue to introduce new technologies and product specifications are subject to
change without prior notice.
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Appendix I Lightning and Surge
Outdoor Dome Camera need to consider lightening, anti-surge, on the premise of ensuring
electrical safety, may take the following measures:


Signal transmission lines and high voltage equipment or high voltage cables must be at least
50 meters distance between；



Try to choose outdoor wiring along the eaves line；



For open field must be sealed steel tubes buried cabling, grounding and steel pipe, the
absolute prohibition of the use of overhead wiring；



In areas of severe thunderstorm or high-voltage area (such as high-voltage substations),
lightning protection equipment, as well as for additional installed power must be taken
measures such as installing lightning rods



Outdoor lightning protection and grounding design of devices and circuits must be
combined with building mine requires unified consideration and in accordance with the
requirements of the relevant national standards, industry standards；



System must be equipotential earthing. Earthing system anti-interference must be met and
the dual requirements of electrical safety, and shall not be mixed with strong power network
neutral wire shorted or separately when grounding, grounding impedance less than 4 ohms,
ground wire cut-area must be not greater than 25mm2 lines shorted
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Appendix II::Hoisting construction Guide
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